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 HRECTrack Introduction

The HRECTrack software is tailor-made for Human Research Ethics Committees (HRECs), enabling staff to enter and track 
research projects and their associated researchers and sponsors. It also tracks HREC members and meetings, enables 
electronic document storage and retrieval and supports reporting functionality, simplifying the ethics and governance 
requirements of day-to-day HREC management in accordance with the National Statement on Ethical Conduct in Research 
Involving Humans issued by the National Health and Medical Research Council together with other relevant federal and state 
legislation and regulations.

The purpose of this document is to provide details regarding the HRECTrack system. As a user guide, it provides details 
about day-to-day system usage and functionality. 

For a PDF version of this help guide, click here.

  If you need to download the latest PDF viewer, click here.

Who is this Guide for ?

This guide is designed for a small number of users who are responsible for operating the system.  The guide assumes that 
users are familiar with the day-to-day business requirements of a Human Research Ethics Committee.

As far as possible this guide avoids undue reference to technical or underlying database administration terminology.  A 
separate administration manual has been prepared for the benefit of Information System personnel responsible for 
implementation and ongoing support and maintenance of the system.

How to use the Guide

It is recommended that this guide be read from front to back in one sitting and that the user makes notes (refer to the notes 
section) on procedures that may be new, are likely to be forgotten or need additional explanation.  

Screenshot examples are used to enable the user to reference parts of the system interface that is being used.  
Modifications to the system may call for a revision of the guide from time to time.   

Users may refer to the Administration Guide for questions of a technical nature.
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 Getting Started

HRECTrack offers an intuitive, web based interface, however there are still some tips that will make using the system easier.

The Administration area is be used to enter all HREC Members, Sponsors, Researchers, Meetings, and User information 

before they can be used or referenced on projects. This area will be used heavily initially; but remember to visit here before 
creating new projects - it will save round trips.

Also, within projects,  Documents can be referenced (and soft copies uploaded if required). Only after they are uploaded 

into documents can they be associated with other project areas, like  Compliance - Insurance and  Progress 
Reports.  The order that this is done is important to simplify the process - don't forget to create the document reference 

first, then it can be associated in the other areas.
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 Login

Users must establish their credentials by entering a valid login name and password via a login page in order to access the 
system. 

Some key factors about the password are :-
· it IS case sensitive!
· it needs to contain at least eight (8) characters, consisting of at least one (1) upper case letter, one (1) lower case 

letter and one (1) numeric digit.

Note that the “Enter” key can be pressed after any entry to commence login, rather than having to click the “Login” button. 

If this is the first time the user has logged into the system, their password will depend on how the administrator has set 
them up. There are two (2) possible options:-

1. The default is to allow the user to enter their desired password at first login, and the system will then prompt for a 
confirmation. 

2. The administrator may also have reset the password to “password”, and the system will then prompt the user to 
change it to their desired setting. This later option is also what will occur if a user has forgotten their password, and 
an administrator resets it for them.

An invalid login produces the message show below. 

For a new user, initial entry of a desired password will produce the following prompt. In this case, please re-enter the 
password, and also confirm it, then select the “Login” button.
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Where the administrator has set the password to “password”, the system will request that it be changed. Enter “password” 
into the initial login screen, then the following screen appears. Enter the details, then select the “Login” button.

Please note that more than five (5) incorrect login attempts will disable the account. To reset the account :-

· An administrator is required to reset the account via the Administration > Users, or, 

· a successful login attempt AFTER waiting 30 minutes will also reset the account.

For additional security when integrated login has not been selected, the system also looks for logins from ‘unknown’ 
locations, that is, login attempts from computers that HRECTrack has not received a valid login from previously. An example 
would be the first login at your work location, or from home or an internet café. If this is detected, then the login screen also 
requires a ‘CAPTCHA’ (Completely Automated Public Turing test to tell Computers and Humans Apart) validation, where you 
will be prompted to type in the characters from an image, as follows :-
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This ‘CAPTCHA’ feature can be turned on permanently if required, so that it appears for each and every login.

Request Password Reset

Requesting a password reset expands the page to display a "Yes, Request Reset!" link

Selecting this option attempts to find the entered 'User Name' in the database, and generate an email to the user with a 
special link allowing the reset to take place.
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If there is a problem, like the 'User Name' cannot be found, then an appropriate message will be displayed.

The email generated by the system will have a subject like "HRECTrack - Password Reset Request", and the contents will be 
like 

Selecting the "Reset Password Now" link will open a browser window, and if successful, will display something like

Note that if you don't get the email, please check your junk/spam email filters before contacting your HREC !

Logout

Selecting the Logout tab logs the user out, and returns to the login screen as follows :-
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 Advanced Filter

Aside from a basic text box filter option above the main paginated lists, an advanced filter option is also available.

The  option opens the advanced filter popup list. The tooltip for this filter button also offers quick select options :-

Please see further down this page for details on the filter criteria available.

After clicking the  option, or selecting the 'Open Advanced Filter' from the tooltip the Advanced Filter page is opened. 
There are no criteria selected, so the screen will look something like the following:-
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The  icon indicates that the filter is a user (non-system) filter. System filters are listed prior to user filters.

Selecting the  icon next to a system/user search sets the appropriate filter options in the lower portion of the screen, 
ready for filtering, but allowing the user to change filter criteria. 

Selecting the  icon applies the search criteria, and performs the filter back on the original screen.

Selecting the  icon for a user filter provides the option of promoting a user filter to a system filter, making it available for 
all other users (this is only available for administrator users).

Selecting the  icon provides the option for a user to delete one of their own filters.

If, for example, the “Alerts - All” system filter was selected ( ), the lower portion of the screen would look something like 
:-
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When the filter is ready to be applied – click the “Filter” button.

The “Clear” option clears the filter criteria on the calling page, and closes the advanced filter popup window, while the 
“Support” button emails the checked filter criteria to support.

“Cancel” simple closes the popup filter window.

Whenever the filter criteria is changed, you should select the ‘Check’ button, to ensure that the plain English description of 
the filter makes sense (they can get complicated). This is a critical step, as it sets up the filter, and tooltips on the ‘Filter’ 
button. Regardless, clicking the ‘Filter’ button always checks the filter before applying. 

The ‘Filter Name’ text area is where you can enter the label/name of the search as it will appear in your previous search list 

(under the  section of System Filters). Note that it only appears when you have NOT matched a system filter, also, if you 
re-use a label/name, it will replace the previous criteria. Only the last ten (10) non-system filters are displayed for each 

user. The tooltip for the  image provides the date and time when the filter was first created, and the tooltip for the filter 
name displays it’s criteria.

Please note that at this stage, only the developers of HRECTrack are able to:-

1. Modify default values and operator that appear when you initially add a field ,
2. Modify default values for existing searches, so that they change relative to time. For example, you might always 

want a date to default to the date of the last meeting, or the next meeting. This can be done, however, it is not 

available via the UI at this stage. Please contact us if you want a query modified or enhanced in this way.

Document Contents

Advanced project search can search within certain uploaded documents, enabling a word, word(s) or phrase(s) search to be 
conducted when the 'Document Contents' filter criteria is selected. Document content (file) searches can be combined with 
other (database) criteria in one seamless advanced search.

The following file type(s) can be searched by the system :-

· doc (Microsoft Word),

· docm (Microsoft Word),

· docx (Microsoft Word),

· txt (Microsoft Word),

· odt (Open Office Document Text),

· pdf (Adobe Portable Document Format).
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All other file types (like MS Excel) cannot be searched at this stage.

Due to the fact that document contents can dictate the results of project(s) returned by an advanced filter, the  icon is 

displayed in the status column of the relevant row of the  Project Documents list, indicating that this documents contents 
was a reason the project passed the filter criteria.

There are some anomalies to note with regard to searching PDF file(s). If documents are uploaded into the system, and the 
user has selected the 'To PDF?' check box, then the resulting PDF file can be text searched. Existing PDF file(s) that are 
uploaded may not be able to be searched because either :-

1. The PDF contains images rather than text (mainly when a document is scanned and saved as PDF), or

2. The PDF has been converted by an application that renders non-standard/non-searchable text. 

While all these PDF files appear human readable, the format of their actual contents may not be searchable.

Also note that if an error occurs in a document contents advanced project search, the alert  icon appears near the filter 
text box (near the top right hand corner), and the icon tooltip gives details of the failure.

Criteria - Projects

Filter criteria relating to Projects include :-

· Actions :-

· Action Date Action By,

· Action Detail,

· Action Outcome,

· Amendment :-

· Amendment Detail,

· Amendment Notes,

· Approved Site,

· Archived Location,

· Billability,

· Category,

· Category - Of Participants,

· Expected Number - Of Participants,

· Comments,

· Communication :-

· Communications With,

· Communication Details,

· Communication Type,

· Communication Date,

· Communication Created By,

· Communication Action Detail,

· Communication Action By,

· Communication Action For User.

· Compliance Fields :-

· Compliance Entity,

· Compliance Data Field Value,
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· Compliance Data Field Comment.

· Date Approved,

· Date Archived,

· Date Closed,

· Date Expected Completion,

· Date Received,

· Devices :-

· Device Details,

· Dispose:-

· Dispose Notes,

· Dispose On Or After Date,

· Dispose X Years After Close,

· Disposed Date,

· Document :-

· Document Date Approved,

· Document Date Received,

· Document Description,

· Document Contents - searches the file contents. See Document Contents for full details,

· Document File Name - searches the file name,

· Document Is Billable,

· Document Is Invoiced,

· Document Can Invoice,

· Document Notes,

· Document Type,

· Document Version,

· Drug :-

· Drug Details,

· Ethics :-

· Ethics (External) Organisation,

· Ethics (External) Reference Details,

· Ethics (External) Reference Number,

· Ethics (External) Review Date,

· Ethics Details,

· Ethics HREC Member,

· Ethics Review Date,

· Ethics Review Type,

· HREC Member :-

· HREC Member,

· HREC Member Given Name,

· HREC Member Initials,

· HREC Member Surname,

· HREC's Approved,

· HREC's Involved,
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· Insurance :-

· Insurance - Type Of,

· Insurance - Type Of Policy,

· Insurance Notes,

· Insurance Policy Number,

· Insurance Provider,

· Insured Amount,

· Level Of Risk,

· Linked :-

· Linked - Future Project Code,

· Linked - Past Project Code,

· Meeting :-

· Meeting Date,

· Meeting Link Date,

· Meeting Comments (General for Project and any children), 

· Meeting Project Comments, 

· Meeting Document Comments, 

· Meeting Action Comments, 

· Meeting Amendment Comments, 

· Meeting SAE Comments, 

· Meeting Update Comments,

· Next Ethics Review Date,

· Next Insurance Date,

· Next Progress Report Date,

· Phase,

· Project :-

· Code,

· Code External / Other,

· Project Can Invoice,

· Project User (only active Project Users) :-

· Specific User,

· User First name,

· User Last name,

· User Email,

· Research :-

· Research Area,

· Researcher Comments (PI, Chief, Contact or other),

· Researcher Given Name (PI, Chief, Contact or other),

· Researcher Surname (PI, Chief, Contact or other),

· Researcher PI Comments,

· Researcher PI Given Name,

· Researcher PI Surname,

· Researcher Chief Comments,
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· Researcher Chief Given Name,

· Researcher Chief Surname,

· Researcher Contact Comments,

· Researcher Contact Given Name,

· Researcher Contact Surname,

· Researcher Mail To Comments,

· Researcher Mail To Given Name,

· Researcher Mail To Surname,

· Researcher Invoice To Comments,

· Researcher Invoice To Given Name,

· Researcher Invoice To Surname,

· Severe Adverse Event :-

· Severe Adverse Event - Any Connection To HREC,

· Severe Adverse Event - Detail,

· Severe Adverse Event - External Ref No,

· Severe Adverse Event - Incident Date,

· Severe Adverse Event - Is Device Related,

· Severe Adverse Event - Is Drug Related,

· Severe Adverse Event - Outcome,

· Severe Adverse Event - Was It A Death,

· Sponsor Name,

· Sponsor Type,

· Status,

· Timer Calendar Day Count,

· Timer Week Day Count,

· Title,

· Update(s)

· Notes,

· Participants - targeted,

· Participants - screened,

· Participants - current,

· Participants - withdrawn,

· Flags (Can) :-

· Can Invoice,

· Flags (Has) :-

· Has Actions Future,

· Has Actions Outstanding (has non-future, non-approved actions),

· Has Alerts - Action Date (future alerts within X days, where X is the 'DateAlertDaysProjectActions' configuration 
setting),

· Has Alerts - Any,

· Has Alerts - Any Date (do any date alerts exist?),

· Has Alerts - Critical (require immediate attention e.g. actioning date is in the past),

· Has Alerts - Ethics Date (ethics alerts within X days, where X is the 'dateAlertDaysProjectEthics' configuration 
setting),
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· Has Alerts - Insurance Date (insurance alerts within X days, where X is the 'DateAlertDaysProjectInsurance' 
configuration setting),

· Has Alerts - Other (Non Critical, Non Urgent),

· Has Alerts - Progress Report Date (progress report alerts within X days, where X is the 
'DateAlertDaysProjectUpdate' configuration setting),

· Has Alerts - Urgent (are there any urgent alerts e.g. action date within the configured alert window),

· Has Amendments,

· Has Amendments Outstanding (are there any non-approved amendments?),

· Has Compliance Issues (are there any invalid or incomplete compliance questions?),

· Has Dispose On Or After Passed (can a project be disposed based on the specified 'Dispose On Or After' date?),

· Has Insurance,

· Has Severe Adverse Events,

· Has Timer Active,

· Has Timer Overdue (timer is overdue based on the 'ProjectTimerAlertDays' and 'DateAlertDaysProjectTimer' 
configuration settings),

· Has Updates Pending,

· Flags (Is) :-

· Is Archived (based on date or status),

· Is Closed (based on date or status),

· Is Discontinued (based on the status),

· Is Disposed (based on date or status),

· Is Insurance Required (based on project flag, so can check this against 'Has Insurance' criteria),

· Is Invoiced,

· Is Multi HREC,

· Is Suspended (based on status),

· Is Withdrawn (based on status).

Criteria - Meetings

Filter criteria relating to Meetings include :-

· Document Cutoff Date,

· Duration (hours),

· Meeting Date,

· Notes,

· Project Cutoff Date,

· Submissions Date,

· Has Alerts - Any (which looks for system alerts),

· Is Enabled.

Criteria - Researchers

Filter criteria relating to Researchers include :-

· Comments,

· Given Name,
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· Initials,

· Surname,

· Has Alerts - Any (which looks for system alerts),

· Is Enabled.

Criteria - Sponsors

Filter criteria relating to Sponsors include :-

· ABN,

· Key Contact,

· Name,

· Sponsor Type,

· Has Alerts - Any (which looks for system alerts),

· Is Enabled.

Criteria - HREC Members

Filter criteria relating to HREC Members include :-

· Category,

· Comments,

· Given Name,

· Initials,

· Is Core NHMRC Category ?

· Is Institutional ?

· Name Prefix,

· Name Suffix,

· Surname,

· Tenure Commenced,

· Tenure Expired,

· Has Alerts - Any (which looks for system alerts like tenure expiry, etc),

· Is Enabled.

Criteria - Users

Filter criteria relating to Users include :-

· First name,

· Last Activity Date,

· Last Name,

· Third Party Id,

· User Name (Login),

· User Type,

· Has Alerts - Any (which looks for system alerts),

· Is Enabled.
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 Interface Overview and Concepts

Some of the key interface concepts used in the HRECTrack web interface are :-

1. Information presented in different sections may contain long lists of data which are paginated, with page navigation 

options at the bottom of the page. 
The page up (PageUp) and page down (PageDown) keys also drive the previous and next page buttons respectively.
In addition, there is a basic filter option above the list, which enables the list size to be reduced.

Simply enter the desired text into the text area, and press “Enter”, or click on the “Filter” button to apply the filter.  

For advanced filtering, select the  icon to the left of the filter area. The tooltip for the text box indicates how the 

filter will be applied.

2. Status information is indicated by icons on the left hand side of lists. Rollover text in the tooltip indicates the nature 
of the status information.

e.g. 

3. Options available are indicated by icons on the right hand side of lists. Rollover tooltip text indicates the nature of 
the option / action that can be taken.

e.g. 

4. Action buttons for edit pages are located at the bottom right hand corner of the page

The “Save/Update” option may be greyed out if your user does NOT have permission to perform the function.  
Sometimes “Cancel” appears as an option (rather than “Back”).  “Cancel” appears on edit screens and returns from 
the edit option to the list screen.  

5. The “New” button enables a new record of a relevant type to be created. For example, if you are looking at the 

“Projects” list, it will bring up a screen to create a new project.
This option may be greyed out if your user does NOT have permission to perform the function.

6. Navigation between sections is via the menu at the top of the screen.

7. When editing fields, the light blue background indicates that the field is mandatory, and cannot be blank. In addition, 
most dropdowns will require a value other than “Unknown”.

8. Tooltips over buttons and images provide additional information about the relevant section. In some cases, the 
tooltip may also contain links which can :-

· be selected to apply a filter (e.g. previous project links), 

· go to a new section (e.g.  when project insurance is required), 
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· go to a new section (e.g.  when project insurance is required), 

· or provide an email or web link. The web link opens a new browser window, displaying the desired link, 

while the email link opens a new email in the current email client.

9. Some text areas support the conversion of text to special characters. These include :-

· (TM) becomes ™, 

· (C) becomes ©,

· (R) becomes ®,

· (o) becomes o, 

· (>=) becomes 

· (<=) becomes 

· (!=) becomes 

· (=) becomes 

· (u) becomes µ

· (+-) becomes ±, 

· (2) becomes ², 

· (3) becomes ³, 

· (a) becomes α, 

· (b) becomes β,

· (o|) becomes Ф, 

· (z) becomes Ω, 

· (PI) becomes π , 

· (1/4) becomes ¼, 

· (1/2) becomes ½, 

· (3/4) becomes ¾, 

· (1/8) becomes 

· (3/8) becomes 

· (5/8) becomes 

· (7/8) becomes 

10. The spell checker is placed next to relevant text fields in the system. By selecting the  icon, the spell checker is 
started. The subsequent pop-up window offers all the standard options, as well as the ability to add custom words 
to the dictionary for your HREC. Behind the scenes it references two (2) built in dictionaries - an AU English 
dictionary (approx 50,000 words), as well as an AU Medical dictionary (approx 74,000 words).
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10.

to the dictionary for your HREC. Behind the scenes it references two (2) built in dictionaries - an AU English 
dictionary (approx 50,000 words), as well as an AU Medical dictionary (approx 74,000 words).

11. The calendar control enables the selection, and clearing of dates.

 

12. The combo box (dropdown) selector enables selection of an option. 
For list containing more than a few items (about 25), typing in the text area can also filter the available options. 
Please note that this has a small delay (about ½ sec) after you stop typing before finding the options that match 
your entered text.
Where the number of options available is very large, only the current option may initially be loaded. When you select 
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12. The combo box (dropdown) selector enables selection of an option. 
For list containing more than a few items (about 25), typing in the text area can also filter the available options. 
Please note that this has a small delay (about ½ sec) after you stop typing before finding the options that match 
your entered text.
Where the number of options available is very large, only the current option may initially be loaded. When you select 
the combo box, a small progress meter may appear, and complete the loading of all options available.
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 Tutorials / Training Materials

Please refer to the main HRECTrack web site (www.hrectrack.com.au) for all tutorial/training materials.

While the training videos provide a walk-thru of various features, this online help system provides the latest information on 
system functionality and features.
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 E-Docs (Electronic Document Management)

HRECTrack has the ability to import certain electronic (i.e. non-paper) documents.
Broadly, these are :-

·  HREA Application (zip file), 

· HRECTrack PDF E-Docs.

Management of HREA / PDF E-Doc documents, including uploading and issue identification are all handled via the 

'Dashboard - EDM' page.

HRECTrack PDF E-Docs include :-

·  (Researcher) Application Form,

·  Project Application Form,

·  Progress Reports,
·  Amendments, 
·  Severe Adverse Events, and

·  Documents (default).

These PDF E-Docs documents can be filled in on any device (PC, Mac, Apple or Android), at the researchers leisure, and 
once completed, can be emailed to the HREC, or uploaded by the Researcher into HRECTrack directly (provided the HREC 
has given access to the Researcher).

n.b. We STRONGLY recommend Adobe Reader as the editor of choice on EVERY platform (yep, underlined, in bold, that 

strongly) !

Once uploaded, the HREC administrator can vet the document (via  on their dashboard), review any issues, and liaise with 
the researcher if required.

Once satisfied that the 'form' has been successfully completed, they can select the import ( ) option to get HRECTrack to 
process the document, which, depending on the document type, will :-

·  Researcher Application Form :-
· Create a new researcher 

n.b. will NOT duplicate/overwrite existing researcher, see below.
· Add the email contact for the researcher,
· Optionally add other contact options,
· Optionally add other address options.
· Open the new researcher record for additional updates by the administrator.

· Project Application Form :-
· Create a new project in the system,

· Associate the PDF document to the project as an application,
· Optionally associate drug(s) details,
· Optionally associate device(s) details,
· Optionally associate previous project link(s),
· Optionally create and/or associate a sponsor.

n.b. Sponsors are uniquely identified by their ABN, and an existing Sponsor will not be duplicated or 
overwritten.

· Optionally create and/or associate researcher(s) according to their pre-defined roles (e.g. Principle, Chief, 
etc). 

n.b. will NOT duplicate/overwrite existing researcher, see below.

· Open the new project record for additional updates by the administrator.

·  Progress Report,
· Create a new Progress Report against a project,

· Associate the PDF document to the project and the Progress Report.
· Open the new progress report record for additional updates by the administrator.

·  Amendments,
· Create a new Amendment against a project,

· Associate the PDF document to the project and the Amendment.
· Open the new Amendment record for additional updates by the administrator.

·  Severe Adverse Events,
· Create a new Severe Adverse Event against a project,

· Associate the PDF document to the project and Severe Adverse Event.
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· Open the new Severe Adverse Event record for additional updates by the administrator.

·  Documents,

· Create a new Document against a project,
· Optionally sets the document type (details below) otherwise 'Unknown' type,
· Open the new Document record for additional updates by the administrator.

Technical Bits N Pieces...

E-Docs (electronic documents) can be created and controlled by the HREC.
The following section outlines what is required in an Electronic Document for HRECTrack to process it.

Creation of the document (form) can be performed in tools like Adobe Acrobat DC.

Alternatively, we use and recommend Jonathan Pike to create your forms.

To create an editable PDF document, HRECTrack expects the document to conform to some basic conventions, namely :-
· meta-data tags (document properties) set for the document :-

· hrecCode - the 'internal' code for the HREC,
· hrecDocType - denoting the type of document, namely :-

· "Project",
· "Amendment",
· "ProgressReport",
· "SAE", 
· "Researcher",
· "HMReview", or
· "Document".

· hrecProjectId - is the project identifier for a specific project. 
Can be derived from the "ProjectCode" document field (see below). 
This tag is only required for :-

· "Amendment",
· "ProgressReport", or
· "SAE".

· hrecDocTypes, and if absent, 
· hrecDocTypeId - only applies to hrecDocType = "Document". If present, this is the TypeId (see below) of 

the document type being imported. When absent, it is defaulted to the 'Unknown' document type; and can 
be changed by the admin.

· editable document fields defined for the relevant type as per the details below.
· a help link to the E-Docs Help page of this guide can also be included, see next section.

Once created, E-Docs can appear under the  'Reports' icon in the project listing. If selected, the E-Doc has the following 
information 'stamped' into it before export/download to the user :-

· hrecProjectId - meta-data field stamped for import,
· ProjectCode - display field in document,
· Title/ProjectTitle - display field in document,
· ProjectPI - principal investigator display field in document,
· CurrentUser - display name of the current user.

Help Link
Just like the web site, the following help link (with this 'question mark' image) can be included in an E-Doc to take users to 
the E-Docs Help page in this help system.
The url is https://www.hrectrack.com.au/help/?id=HRECTrack_EDocsHelp.

 HREA

The HREA application is actually a zip file containing a number of documents and other information.

It is controlled and generated by the NHMRC, and you can find more details here HREA. 

Once completed, it is down-loadable by Researchers as a zip (compressed) file.
Inside each HREA zip file is :-

· PDF of the application,
· DOCX (MS Word) of the application,
· RTF of the application,
· XML file of all the fields etc for the application,
· All other attachments uploaded / included in the application.
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HRECTrack maps the following HREA questions / fields :-

HRECTrack Field Name HREA Field(s)
Project Code 
External/Other

HREA Code

Title Q1.1

Comments Q1.2
Application Type
Q1.3
Q1.4 / Q1.4.1
Q1.5
Q1.6
Q1.7
Q1.8
Q1.13
Q4.3
Q4.4
Q4.5
Q4.6
Q4.7
Ancillary Acknowledgment fields.

Category(s) Of 
Participants

Matches selected responses.

Date Expected Start Q1.7

Date Expected Completion Q1.7 + Q1.8 Timeframe

Previous Link HREA 'Copied From' field.

Researchers Imports all Researchers, with a limit of nine (9) 'Other' researchers.

HRECTrack attaches the following documents :-

HREA Attachment HRECTrack Document Action
Q1.12 - Evaluations Evidence Imports as 'HREA Application Appendix'.

Q1.13 - Ethics Evaluation  Imports as 'HREA Application Appendix'.

M2.3.3 - Biospecimen Analysis Imports as 'HREA Application Appendix'.

Q4.1 - Protocol Imports as 'Protocol'.

Team Member Signature File Imports as 'HREA Application Appendix'.

Q4.2.1 - Other Document(s) Imports each entry as 'HREA Application Appendix'.

Any 'loose' documents in 
application zip.

Imports as 'HREA Application Appendix'.
This has been included so that future HREA attachments NOT 
immediately identified by HRECTrack will still be imported. 

Please see the 'Dashboard - EDM' page for details regarding importing.

 Documents
The document is mentioned first here because it is the default type if no other hrecDocType can be determined. 
It requires the "hrecCode=?" and "hrecDocType=Document" meta-data tags to be set.
Optionally, then hrecDocTypeId meta-data tag can also be set (as per details below) to identify the type of document.
Ideally, the "hrecProjectid=?" meta-tag would also be set, but the ProjectId can be derived from the ProjectCode field.
Additionally, the following form fields can be defined :-

Field Name Max Length Details
ProjectCode * 50 Is a required field that can be used to derive the 

projectId if the hrecProjectId meta-data tag is absent.

Description  No Limit

DocumentTypeId  Lookup As per the hrecDocTypeId meta-data tag values below.

* denotes mandatory field.
n.b. If 'exported' from HRECTrack, the document has its internal hrecProjectId stamped, as well as having the ProjectCode 
field populated. Optionally, if a document field called 'Title' exists, it will also be populated with the project title.
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Valid values for the hrecDocTypeId meta-data tag are :-
· 0 - Other (default if none specified)

· 2 - Application Cover Sheet

· 4 - Plain Language Statement

· 5 - Letter Of Support

· 6 - Budget

· 7 - Protocol

· 8 - Protocol Amendment

· 9 - Protocol Supplementary

· 10 - Drug Document

· 11 - Device Document

· 12 - CTN Forms

· 13 - CV

· 14 - Indemnity

· 15 - Patient Information and Consent (PIC) Form

· 16 - PIC supplementary

· 17 - Pregnant partner release form

· 18 - HREC approvals at other sites

· 19 - Advertisement/s

· 20 - Investigator Drug Brochure

· 21 - Diary Cards

· 22 - Project Summary

· 23 - Newsletters To Participants

· 24 - Notices

· 25 - Letters

· 26 - Protocol Deviation

· 27 - File Notes

· 28 - Addendums

· 29 - Permission To Contact Form

· 30 - Data Collection Form

· 31 - Protocol Violations

· 32 - Administrative Changes

· 34 - Clinical Trial Research Agreement

· 35 - Patient Declaration Of Continued Study

· 37 - Memo

· 38 - Insurance

· 40 - Tools

· 42 - Questionnaire

· 43 - Site Specific Assessment

· 44 - Change In Personnel Form

· 45 - Research Checklist

· 47 - Radiation Safety Report

· 48 - Site Authorisation Checklist

· 49 - HREC Sub-Committee Checklist

· 50 - Consent Form

· 52 - Memorandum of Understanding

· 53 - Publication 

· 54 - HREA Application Appendix

· 55 - HRECMember Review
· ?

 Researcher Application Form
The researcher document requires the "hrecCode=?" and "hrecDocType=Researcher" meta-data tags to be set.
Note that Researchers are uniquely defined based on their email address. Where an email address is found against multiple 
existing researchers, uniqueness checks are extended to include the surname (last name) field as well. If an existing 
researcher is found, NO changes are made, and the import is ignored!
Additionally, the following form fields can be defined :-

Field Name Max Length Details
NamePrefix 100

GivenName * 100

Surname * 100

NameSuffix 100
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Field Name Max Length Details
NamePrefix 100

GivenName * 100

Surname * 100

NameSuffix 100

Comments -

ContactEmail * 200

ContactEmailIsPrimary - 0 / 1 (zero or one)

ContactPhoneHome 200

ContactPhoneHomeIsPrimary - 0 / 1 (zero or one)

ContactPhoneWork 200

ContactPhoneWorkIsPrimary - 0 / 1 (zero or one)

ContactFax 200

ContactFaxIsPrimary - 0 / 1 (zero or one)

ContactMobile 200

ContactMobileIsPrimary - 0 / 1 (zero or one)

ContactWeb 200

ContactWebIsPrimary - 0 / 1 (zero or one)

Postal Address (Group)

AddressPostalAddress #  500

AddressPostalSuburb #  100

AddressPostalState #  100

AddressPostalPostcode #  50

AddressPostalCountry #  100

AddressPostalIsPrimary 0 / 1 (zero or one)

Work Address (Group)

AddressWorkAddress # 500

AddressWorkSuburb # 100

AddressWorkState # 100

AddressWorkPostcode #  50

AddressWorkCountry # 100

AddressWorkIsPrimary 0 / 1 (zero or one)

Home Address (Group)

AddressHomeAddress # 500

AddressHomeSuburb # 100

AddressHomeState # 100

AddressHomePostcode # 50

AddressHomeCountry # 100

AddressHomeIsPrimary 0 / 1 (zero or one)

* denotes mandatory field.
# denotes a mandatory field within a field group or block (in essence, if ANY field in the group is entered by a researcher, 
then the # fields become mandatory, otherwise the group as a whole is optional).

Project Application Form
The project application form document requires the "hrecCode=?" and "hrecDocType=Project" meta-data tags to be set.
Additionally, the following form fields can be defined :-

Field Name Max Length Details
ProjectCodeExternal  50 External/Other Project Code  
Title * 2000

Comments No Limit

ResearchAreaId Lookup Predefined value from list:-
0 - Unknown
1 - Arthritis
2 - Asthma
3 - Auto-Immune Disease
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Title * 2000

Comments No Limit

ResearchAreaId Lookup Predefined value from list:-
0 - Unknown
1 - Arthritis
2 - Asthma
3 - Auto-Immune Disease
4 - Cancer
5 - Complementary Medicines
6 - Dermatology
7 - Diabetes
8 - Gastroenterology
9 - Infection Control
10 - Medical Imaging
11 - Men's Health
12 - Nursing
13 - Obesity
14 - Pain Management
15 - Patient Information
16 - Psychiatry
17 - Surgery
18 - Immunology
19 - Rehabilitation
20 - Sleep
21 - Genetics
22 - Models Of Care
23 - Intensive Care
24 - Cardiology
25 - Orthopaedics
26 - Plastic Surgery
27 - Vascular
28 - Respiratory
29 - Paediatric
30 - Neurology
31 - Ear, Nose and Throat
32 - Haematology
33 - Gynaecology
34 - Urology
35 - Ophthalmology
36 - Oral
37 - Endocrinology
38 - Allergy
39 - Pathology
40 - Preventative Medicine
41 - Psychology
42 - Infectious Diseases
43 - Medicine
47 - Obstetrics
48 - Renal
49 - Dietetics
50 - Women's Health
51 - Emergency Medicine
52 - Geriatrics
53 - Lifestyle
54 - Musculoskeletal
55 - Physiotherapy
56 - Allied Health
57 - Palliative Care
58 - Education
59 - End of Life
60 - Health Services
61 - Anaesthetics
62 - Ethics
63 - Medication Management
64 - Rheumatology
65 - Safety
66 - Social Work 

CategoryId Lookup Predefined value from list:-
0 - Unknown
1 - Drug
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64 - Rheumatology
65 - Safety
66 - Social Work 

CategoryId Lookup Predefined value from list:-
0 - Unknown
1 - Drug
2 - Device
3 - Model Of Care
5 - Epidemiological
7 - Diagnostic
8 - Patient Information
9 - Observational
10 - Focus groups
11 - Qualitative - Medical
12 - Qualitative - Non-Medical
13 - Clinical Research
14 - Authorised Prescriber
15 - Database - Medical
16 - Database - Non-Medical
17 - Tissue Bank
18 - Quality Assurance
19 - Registry
20 - Feasibility
21 - Audit
22 - Questionnaire and Interview 

CategoryOfParticipantsIdX Multi
Select List

Predefined list allowing multiple selection(s).
Each option offered must have the field defined, 
being the option value. 
e.g. CategoryOfParticipantsId2 denotes a 
for '2 - Children / Young People (NS4.2)').
Predefined value from list:-
1 - Pregnant Women / Foetus (NS4.1)
2 - Children / Young People (NS4.2)
3 - Dependent or Unequal Relationships (NS4.3)
4 - Dependent on Medical Care (NS4.4)
5 - Cognitively Impaired (NS4.5)
6 - Illegal Activities (NS4.6)
7 - Aboriginal / Torres Strait Islander (NS4.7)
8 - People in Other Countries (NS4.8) 

ParticipantsNumberExpected - 0 to 999 (number)

PhaseId Lookup Predefined value from list:-
0 - Unknown
1 - 1
2 - 2
3 - 2b
4 - 3
5 - 3b
6 - 4
7 - 2a
8 - 3a
9 - Pilot Study 

HRECsInvolved - 0 to 999 (number)

HRECsApproved - 0 to 999 (number)

DateExpectedStart Date in the format dd-MMM-yyyy.

DateExpectedCompletion Date in the format dd-MMM-yyyy.

 EthicsExternalOrganisation 2000

 EthicsExternalReviewDate Date in the format dd-MMM-yyyy.

 EthicsExternalReferenceNumber 200

 InvoiceOrganisationName 100

 InvoiceOrganisationABN 100

 InvoiceAttnTo 100

 InvoiceContactName 100

 InvoiceContactEmail 100

 InvoiceContactPhone 100

 InvoiceContactPosition 100

 InvoiceContactDepartment 100
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 InvoiceContactName 100

 InvoiceContactEmail 100

 InvoiceContactPhone 100

 InvoiceContactPosition 100

 InvoiceContactDepartment 100

 InvoiceAddress 100

 InvoiceSuburb 100

 InvoiceState 100

 InvoicePostCode 100

 InvoiceCountry 100

 DrugDetail1 No Limit

 DrugDetail2 No Limit

 DrugDetail3 No Limit

 DrugDetail4 No Limit

 DrugDetail5 No Limit

 DeviceDetail1 No Limit

 DeviceDetail2 No Limit

 DeviceDetail3 No Limit

 DeviceDetail4 No Limit

 DeviceDetail5 No Limit

 PreviousLink1 50 Project Code / External for a previous project.

 PreviousLink2 50 Project Code / External for a previous project.

 PreviousLink3 50 Project Code / External for a previous project.

 PreviousLink4 50 Project Code / External for a previous project.

 PreviousLink5 50 Project Code / External for a previous project.

 Sponsor Group

SponsorName 500

SponsorABN # 50 If an existing Sponsor is found in the system 
ABN), then that Sponsor is associated to 
and no changes are made to the actual (existing) 
details.

SponsorKeyContactPerson 200

 Researchers Groups Researchers can be entered against projects 
following categories :-

· Principle

· Chief

· Contact

· MailTo

· InvoiceTo

· OtherX (where X is 1-9)

Similar to the  Researcher Application 
this section allows all the researcher fields 
following prefixes to denote the categories 

· ResearcherPrinciple

· ResearcherChief

· ResearcherContact

· ResearcherMailTo

· ResearcherInvoiceTo

· ResearcherOtherX (where X is 1 to 9)
Exactly the same validation rules apply.
If an existing Researcher is found in the 
on email address and surname), then that 
associated to the project for that category, 
changes are made to the actual (existing) 
details.
Note the special XXXProjectResearcherNotes 
goes against each Project <> Researcher link 
system.

ResearcherPrincipleNamePrefix 100
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details.

SponsorKeyContactPerson 200

 Researchers Groups Researchers can be entered against projects 
following categories :-

· Principle

· Chief

· Contact

· MailTo

· InvoiceTo

· OtherX (where X is 1-9)

Similar to the  Researcher Application 
this section allows all the researcher fields 
following prefixes to denote the categories 

· ResearcherPrinciple

· ResearcherChief

· ResearcherContact

· ResearcherMailTo

· ResearcherInvoiceTo

· ResearcherOtherX (where X is 1 to 9)
Exactly the same validation rules apply.
If an existing Researcher is found in the 
on email address and surname), then that 
associated to the project for that category, 
changes are made to the actual (existing) 
details.
Note the special XXXProjectResearcherNotes 
goes against each Project <> Researcher link 
system.

ResearcherPrincipleNamePrefix 100

ResearcherPrincipleGivenName # 100

ResearcherPrincipleSurname # 100

ResearcherPrincipleNameSuffix 100

ResearcherPrincipleContactEmail # 200

ResearcherPrincipleContactEmailIsPrimary 0 / 1 (zero or one)

ResearcherPrincipleProjectResearcherNotes No Limit

etc

* denotes mandatory field.
# denotes a mandatory field within a field group or block (in essence, if ANY field in the group is entered by a researcher, 
then the # fields become mandatory, otherwise the group as a whole is optional).

 Progress Report
The progress report document requires the "hrecCode=?" and "hrecDocType=ProgressReport" meta-data tags to be set.
Ideally, the "hrecProjectid=?" meta-tag would also be set, but the ProjectId can be derived from the ProjectCode field.
Additionally, the following form fields can be defined :-

Field Name Max Length Details
ProjectCode * 50 Is a required field that can be used to derive the 

projectId if the hrecProjectId meta-data tag is absent.

Title 2000 Optional field that is ignored on import, but can be 
populated on export if present.

UpdateNotes * No Limit

ParticipantsNumberCurrent - 0 to 999 (number)

ParticipantsNumberScreened - 0 to 999 (number)

ParticipantsNumberTargeted - 0 to 999 (number)

ParticipantsNumberWithdrawls - 0 to 999 (number)

IsFinalUpdate - 0 / 1 (zero or one)

* denotes mandatory field.
n.b. If 'exported' from HRECTrack, the document has its internal hrecProjectId stamped, as well as having the ProjectCode 
field populated. Optionally, if a document field called 'Title' exists, it will also be populated with the project title.
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 Amendments
The amendment document requires the "hrecCode=?" and "hrecDocType=Amendment" meta-data tags to be set.
Ideally, the "hrecProjectid=?" meta-tag would also be set, but the ProjectId can be derived from the ProjectCode field.
Additionally, the following form fields can be defined :-

Field Name Max Length Details
ProjectCode * 50 Is a required field that can be used to derive the 

projectId if the hrecProjectId meta-data tag is absent.

Title 2000 Optional field that is ignored on import, but can be 
populated on export if present.

AmendmentDetail * No Limit

AmendmentDetail2  No Limit For second text field on another page if required.

* denotes mandatory field.
n.b. If 'exported' from HRECTrack, the document has its internal hrecProjectId stamped, as well as having the ProjectCode 
field populated. Optionally, if a document field called 'Title' exists, it will also be populated with the project title.

 Severe Adverse Events
The severe adverse event document requires the "hrecCode=?" and "hrecDocType=SAE" meta-data tags to be set.
Ideally, the "hrecProjectid=?" meta-tag would also be set, but the ProjectId can be derived from the ProjectCode field.
Additionally, the following form fields can be defined :-

Field Name Max Length Details
ProjectCode * 50 Is a required field that can be used to derive the 

projectId if the hrecProjectId meta-data tag is absent.

Title 2000 Optional field that is ignored on import, but can be 
populated on export if present.

ReportTypeID *  Lookup Predefined value from list:-
1 = Initial
2 = Followup

IncidentDate * - Date in the format dd-MMM-yyyy.

IsDrugRelated - 0 / 1 (zero or one)

IsDeviceRelated - 0 / 1 (zero or one)

AnyConnectionToHREC - 0 / 1 (zero or one)

WasItADeath - 0 / 1 (zero or one)

ExternalRefNo 200

Detail * No Limit

Outcome * No Limit

* denotes mandatory field.
n.b. If 'exported' from HRECTrack, the document has its internal hrecProjectId stamped, as well as having the ProjectCode 
field populated. Optionally, if a document field called 'Title' exists, it will also be populated with the project title.

 HRECMember Review
The HRECMember Review document requires the "hrecCode=?" and "hrecDocType=HMReview" meta-data tags to be set.
Ideally, the "hrecProjectid=?" meta-tag would also be set, but the ProjectId can be derived from the ProjectCode field.
Additionally, the following form fields can be defined :-

Field Name Max Length Details
ProjectCode * 50 Is a required field that can be used to derive the 

projectId if the hrecProjectId meta-data tag is absent.

Title 2000 Optional field that is ignored on import, but can be 
populated on export if present.

ProjectPI  100 Populated on export, ignored on import.

CurrentUser  - Populated on export, ignored on import.

ReviewDetail * No Limit

ReviewDetail2 * No Limit

ReviewDetail3 * No Limit

ReviewDetail4 * No Limit

* denotes mandatory field.
n.b. If 'exported' from HRECTrack, the document has its internal hrecProjectId stamped, as well as having the ProjectCode 
field populated. Optionally, if a document field called 'Title', 'ProjectPI' or 'CurrentUser' exists, they will also be populated 
with the project title. 32



n.b. If 'exported' from HRECTrack, the document has its internal hrecProjectId stamped, as well as having the ProjectCode 
field populated. Optionally, if a document field called 'Title', 'ProjectPI' or 'CurrentUser' exists, they will also be populated 
with the project title.
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 E-Docs End User Help

This section outlines a few helpful tips and tricks around filling in PDF documents.
The documents can be filled in on any device (PC, Mac, Apple or Android).

To achieve the best experience while editing your document, we STRONGLY recommend Adobe Reader as the editor of 

choice on EVERY platform (yep, underlined, in bold, that strongly) !

...
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9. Dashboard

 Dashboard - Overview

The dashboard provides quick and easy access to system status and project status information.

Basic filtering is enabled on all paginated lists.

The "Include Migrated Data?" checkbox enables the inclusion or exclusion of any migrated data from the dashboard 
information. Data can be migrated into HRECTrack as part of the initial system setup.
A dropdown combo box also enables filtering by category.
The filter button applies the selected options to the paginated list.

Summary

The summary page contains a series of pie charts reflecting project status, project messages, and system messages.
All charts are images, so you can right-click the chart and select 'Copy' or 'Save picture as...' to include in your reports.

E-Docs / HREA

The E-Docs (Electronic Document Management) section of the dashboard allows Researchers and Administrators to upload 
certain electronic (i.e. non-paper) documents into HRECTrack
Broadly, these are :-

· HREA Application (zip file), 
· HRECTrack PDF E-Docs.

HRECTrack PDF E-Docs include :-

·  (Researcher) Application Form,

·  Project Application Form,

·  Progress Reports,

·  Amendments, 

·  Severe Adverse Events, and

·  Documents (default).

To upload file(s) :-
· choose them by clicking the button, or 
· drag-and-drop them onto the button

then select the 'Submit' button.
Note that 'Submit' DOES NOT import the document into HRECTrack - it just prepares the document for import, which is a 
separate step!

The resultant uploads are listed, along with any errors or issues, with the following details :-
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Status icons include :-
· Document type, specifically :-

·  - Project / HREA

·  - Progress Report,

·  - Amendment,

·  - Severe Adverse Event,

·  - Researcher (Application)

·  - Document / Other.
· Document Status :-

·  - All Good,

·    - Notices Exist,

·  - Warnings Exist,

·  - Errors Exist (will block importing)
 
Options include :-

·  /  - Project Edit link (if available),

·  - Document Delete - to remove the document from the import list,

·  - Import (Administrators Only),

·  - Document Details pop up, including status information and field details,

·  /  - Document View (if available).

Where the import ( ) option is available, selecting it will :-
· create the relevant database content (against the new/relevant project, and based on the HREA/PDF content),
· absorb the document into the system (against the relevant project),
· for HREA, absorb the other documents against the project,
· display the relevant HRECTrack edit page based on the document type.

HREA Specifics
Since the HREA application is a zip file, containing documents and data, the imported zip file will :-

· Attach the main application PDF as the key for the import, with all data attached and viewable via the  option,
· Attach all other documents as 'children' to the application.

When the Researcher (or you) click the 'Submit' button for an HREA application, you'll see something like :-

Where (1) is the main application, with :-

·  - Document Delete HREA application and also deletes all children, 
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·  - Import - and also does all children listed below the application.
and (2) thru (7) are additional documents tied to the HREA application.

As there is a lot of data in the HREA on Researchers, these are also imported - and the usual rules apply for Researcher 

importing, namely a Researcher is deemed unique based on email address and surname, and existing Researchers will NOT 
be duplicated or updated by an import.

In addition, the original HREA zip is kept with the project, for audit purposes; so you can't get to it, or see it, but its stored 
safely with the other documents.

It's that simple!

See the section on Electronic Document Management for more technical details.

Messages By Project

This page provides a paginated list of messages by project. As such, each line represents a project, and the message(s) are 

listed under each project. This is the same listing that appears in the project header section of project page(s).

The filter contains the categories available to filter, and in brackets the (critical + urgent / future + other) counts for each 
category.
The status column has the usual status icons, functioning as per the Status for a project. 
The option icons in the Project Title / Message(s) column function as per the Options for a project, drilling through to the 
relevant project page. 

Please refer to Status Alerts for details on messages, and their alert colouring.

Messages By Date

This page provides a paginated list of messages by date. As such, each line represents a single message, and its associated 
project.
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The filter contains the categories available to filter, and in brackets the (critical + urgent / future + other) counts for each 
category.
The status column has the usual status icons, functioning as per the Status for a project. 
The option icons in the Project Title / Message(s) column function as per the Options for a project, drilling through to the 
relevant project page. 

Please refer to Status Alerts for details on messages, and their alert colouring.

System Messages

This page provides a paginated list of system (non-project) messages by date. Each line represents a system message.

The status column indicates the area of the system message.

The Options column provides an edit  option that drills through to the relevant edit page.

Current system messages include :-
· HREC Member tenure expiry.
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10. Projects

 Project Overview

The projects tab provides a list of projects that the user has permission to view, from the newest to the oldest. 
Administrative users and HRECMember users can see all projects by default. Other user types need to be associated with 

projects via the  options icon next to each project.

It should be noted at this point that many project options / functions will not be available until the relevant 
meetings, researchers, sponsors, etc have been setup under the “Administration” section.

There are two (2) ways of filtering the projects list :-

1. Using the  advanced filter (see details on filter criteria here) or

2. Entering basic text into the search text box and selecting the ‘Filter’ button.

In either event, the tooltip for the filter text box displays the filtering criteria that will be used. Refer to the advanced filter 
section for more details. 

Note that the filter text may contain a strange sequence of characters and numbers following an advanced search. This is by 
design, since even the simplest advanced search has a complex query format, so this is stored in the database, and the 
reference to the query is the strange sequence (technically known as a GUID – Globally Unique Identifier); and as noted 
above, the textbox and ‘Filter’ button tooltips always tells you what is happening with the search criteria.

The main columns give key details of the project. The tooltip on the Title column provides the project comments.

Status

The Status column shows the status of the project displayed on that line. Each icon has tooltip text that provides further 
details.

The first seven (7) icons may change, depending on the value selected for the project.

·  /  /  /  /  Indicates that the project is active, inactive (discontinued, suspended, or withdrawn), 
closed, archived, or disposed. 
If archived, the tooltip includes the date and location details. 
If disposed, the tooltip includes the date and details.
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·  provides details of the research area in the tooltip,

·  provides details of the category in the tooltip,

·  provides details of the status in the tooltip,

·  provides details of the phase in the tooltip,

·  / /  provides details of the billability and invoicing status in the tooltip,

·  provides details of the HREC Member in the tooltip, and may contain links,

·  displays only where other HREC’s are involved, turning green  when the counter of other approved HREC’s is 
the same as other HREC’s involved.

·  /  displays only when a timer is or was on prior to project approval, and is red if the timer indicates the 
project not approved and is overdue.

·  project severe adverse events. Only appears is they exist.

·  project amendments status. Only appears is they exist.

·  /  displays only if there is an alert or issue with the project.

Status Alerts

If the  or  icon appears, it indicates there are alert(s) for the project. Alerts are simply system messages that are 
being escalated (e.g. approaching, or have passed a key date). The tooltip provides full details. 

Issues include :-

· Project is archived, however the archived date or an archived status ( ) has not been set,

· Project is closed, however the closed date or a closed status ( ) has not been set,

· Project is approved, however the approved date status ( ) has not been set,

· Project is suspended (by selecting a suspended status ),

· Outstanding actions ( ) for the project (date based),

· Project progress updates ( ) are required (date based),

· Project ethics review date is approaching or past,

· Project insurance review date is approaching or past,

· Outstanding compliance issues (either ethics, governance or insurance),

· Where the counter of other approved HREC’s is not the same as other HREC’s involved,

· Where the project timer alert days is approaching or exceeded,

· Where issues exist with the project dispose values (date based),

· And generally, where a date based alert will soon be triggered (urgent), or is due in the past (critical).

The status alert tooltip may look something like :-

where bold red is critical (due in past), red is urgent (due soon), and normal text is a general message (which may 
escalate to an alert).
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Note that date based or date critical alerts are affected by the ‘DateAlertDays???’ configuration settings :-

1. DateAlertDaysProjectActions,

2. DateAlertDaysProjectInsurance,

3. DateAlertDaysProjectUpdate,

4. DateAlertDaysProjectEthics,

5. DateAlertDaysProjectTimer.

For example, if a value is set to sixty (60) days, then 60 days before a date falls due, the system will raise a message to an 
urgent alert (red), and provide a countdown in the tooltip. When the date is today, or in the past, the message becomes a 
critical alert (bold red).

The dashboard provides lists of messages by project and by date, prioritising from critical to future. It provides the easiest 

way to filter, and resolve issues for projects.

Options

The options column  enables actions to be performed for the project. Each 
icon has tooltip text that provides further details for the option.

·  the project to be edited.  The tooltip over this icon provides the database id for this project.

·  the projects documents to be viewed, edited, added. The tooltip indicates the number of unique and total 
number of documents. Some document categories, like “Serious Adverse Events”, “Tools”, and “Progress Report” 
are always treated as individual documents, no matter how many are added. Other documents are treated as 
“versioned”, so newer additions supersede previous ones, hence the document count is not effectedaffected. 
Documents are :-

o “Approved”  when the approved date is today or in the past,

o “Ratified” when it is approved and also where the meeting date is in the past.

·  project actions to be viewed, edited, added.  

o “Actions” is the total number of actions listed against a project;

o “Approved” is the number of project actions where the approved date is in the past;

o “Ratified” is project actions approved and also where the meeting date is in the past;

o “Outstanding” is the difference between the total number of “actions” less “approved” – and is one of the 

triggers for the  status.

·  project updates (progress reports) to be viewed, edited, added.  

The “Comments” text area supports the conversion of text to special characters, as per the “Interface Overview” 

section at the start of the document. Counters include :-

o “past” – when ready to submit is ticked and the meeting date has passed,

o “scheduled”   --  when ready to submit is ticked and the meeting date is still in the future,

o “pending”  -- when scheduled but not yet ready to submit; and

o “required” – when system is waiting for a progress report to be entered.

·  project compliance to be viewed, edited, added. Compliance includes governance, ethics, and insurance. If 
insurance is flagged as required, this icon’s tooltip gives access to the governance and ethics, or insurance screen. 

A special  button with the usual save buttons enabled toggling between these two (2) compliance 
related screens. 
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·

A special  button with the usual save buttons enabled toggling between these two (2) compliance 
related screens. 

·  project drugs to be viewed, edited, added. The “Detail” text area supports the conversion of text to special 

characters, as per the “Interface Overview” section at the start of the document.

·  project devices to be viewed, edited, added. The “Detail” text area supports the conversion of text to special 

characters, as per the “Interface Overview” section at the start of the document.

·  project researchers (investigators) to be viewed, edited, added. Researchers can also be denoted as :-

o Co-Ordinating/Chief  investigator (CI),

o Primary  researcher (PI),

o Contact  researcher (although strictly the contact may not be a researcher, they are entered in the 

Administration > Researcher section for convenience)

·  /  project previous links to be viewed, edited, added.

·  project sponsors to be viewed, edited, added.

·  project users to be viewed, edited, added. This associates system users with projects. This feature can be used 
to associate and dissociate system users (e.g. Researchers, HREC members, etc) to/from projects. While 
administrators can always see the full list of projects, this mechanism is used to filter other users to only their 
required list of projects.

·  /  displays only prior to project approval, and is red if the timer is off, and green if a timer is running.

·  project severe adverse events. Not yet implemented.

·  project amendments can be viewed, edited, added.  

o “Actions” is the total number of amendments listed against a project;

o “Approved” is the number of project amendments where the approved date is in the past;

o “Ratified” is project amendments approved and also where the meeting date is in the past;

o “Outstanding” is the difference between the total number of “amendments” less “approved” – and is one of 

the triggers for the  status.

·  provides a list of project specific reports that may be run for the project.
This also includes relevant E-Docs, which have the ProjectCode and Title filled in on the document during 'export'.

In general, selecting an option will open a specific screen for that option, and you can view the current details, as well as 
adding a new detail for the specific option.

The  button opens a section of the screen for adding a new record of that option type.

The  button returns you to the projects listing, which can also be achieved by selecting the  
tab.

Header

When drilling through to any of the project options (except new project), a project header portion is displayed at the top of 

the page. The following image is for the compliance page ( ) :-
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It provides the basic details for the current project being worked on, as well as enabling simple intra-project navigation and 

action items (as per the  status icon). In addition, the arrow pointer  is used to indicate the issues that can be resolved 
on the current page, while the option icons enable quick selection of the issue, taking you to the page where it can be 
resolved. The messages are coloured, where bold red is critical (due in past), red is urgent (due soon), and a general alert.

The  check box enables the showing or hiding of future messages, not just issues (as per the illustration above). 

Also, the project list navigator  enables scrolling through the list of previously selected project(s) 
(from the 'Dashboard', or the ‘Projects’ tab).

If the meeting management module is enabled, the  icon may appear to offer meeting details, and/or to assist in 

navigating back to the relevant meeting management page.

 Project Edit

Project details can be edited, provided the project is not closed or archived.

Project Code & Meeting Date

The Project code is generated in a default format YYYY_nnn, where the project is the n’th project in the YYYY calendar year 
based on the Date Received (n.b. this format can be changed prior to system implementation).  If it is modified, and derives 
from a field like ‘Meeting Date’, then this field must be completed before saving.
Once saved, the meeting cannot be updated. The list of meetings is derived from all future meetings that can still accept 

project submissions. If no meeting date is set, an alert is created.

Users can also associate the project with other meetings via the meeting management   option.
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Project Code External / Other 

The project code external / other field caters for the scenario where a project is known by the researcher as a 'code' other 
than the one generated by HRECTrack for your HREC. 
It may be an internal 'code' that the researchers have created, or one that another HREC has generated.
In any event, it can be entered here, and searched via the basic and advanced search functions.

Title

The title field provides the main description for the project, and is always required.

It support the conversion of text to special characters, as per the “Interface Overview” section at the start of the document.

Comments

Comments provide an additional area to provide project information.

It support the conversion of text to special characters, as per the “Interface Overview” section at the start of the document.

 Research Area

Defines the research area for the project.

 Category

Defines the category for a project, and as below, also impacts the Dispose On or After Date.

 Category(s) Of Participants

Defines the category or participants for a project.

 Expected Number of Participants

Defines the expected number of participants for a project.

 Status

Enables the project status to be tracked, and also has a number of flags associated with each phase.

It should be noted that the system will NOT stop you selecting an invalid state, however, it will raise alerts via the  icon if 
there are any inconsistencies. 

Status Is 
Suspended

Is 
Discontinued

Is 
Withdrawn

Is 
Archived

Is 
Closed

Is 
Disposed

Unknown3 - - - - - -

Received3 - - - - - -

Pending3 - - - - - -

Approved2,4 - - - - - -
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Received3 - - - - - -

Pending3 - - - - - -

Approved2,4 - - - - - -

Rejected - - - - True -

Withdrawn - - True - True -

Recruitment Ceased2 - - - - - -

Abandoned - True - - True -

Discontinued - True - - True -

Suspended True - - - - -

Study Complete4 - - - - True -

Archived – Abandoned - - - True True -

Archived – Discontinued - - - True True -

Archived – Rejected - - - True True -

Archived - Study 
Complete

- - - True True -

Archived - Withdrawn - - True True True

Disposed1 - - - True True True

1. ‘Disposed’ is a status that the system sets when the user enders a value for ‘Disposed Date’. It is not available in the 
status dropdown by default.
2. These states are considered 'Approved' states.
3. These states are considered by the system as pre-approved states.
4. These states may have sub states (e.g. Approved - Extension, or Study Complete - Extension Not Approved).
n.b. the key dates “Date Approved”, “Date Closed” and “Date Archived” cross-reference these status flags to provide an alert 

via the  icon if a flag and/or date are out of sync.

 Phase

Allows for the phase of the project to be recorded.

 Billability 

Allows for the billability of the project (and associated documents) to be specified.

 Level Of Risk 
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Specifies the level of risk for the project. Must be set otherwise an alert is created. 

Historically this used to tie closely to the Ethics Review Type, however it was modified to represent a basic risk scale.

 Ethics Review Type 

Specifies the type of ethics approval required by the project. The ethics details are handled on the Compliance pages ( ), 
see Compliance sections for further details.

n.b. once the project is approved, the “Ethics Review Type” option cannot be altered. Must be set otherwise an alert is 
created.

 HREC Member 

Enables the selection of a HREC Member for the project. 

Since a User can be associated with a HREC Member, then that user can automatically 'see' the project, and this is indicated 
via the Project Users page.

This HREC Member link also applies where they are associated with project documents, actions, amendments, or severe 
adverse events.

HREC’s Involved / Approved 

Allows the number of other HREC’s involved to be entered. Where the number involved does not equal the number 

approved, an alert is noted via the status icon ( ). In addition, the status icon displays, and remains blue ( ).

 Principal Investigator (PI)

Can also be selected for the project. Full options for selecting the Co-Ordinating/Chief (CI), Principal (PI), and Contact 

investigator / researcher are available via the Project > Researchers    option.

Is Insurance Required 

Is a key flag for compliance. If required, it enables the insurance page under the compliance section, as well as enabling the 
“Next Insurance Review Date” field in the “Key Dates” section. If this option is NOT ticked, then the “Next Insurance Review 
Date” field, and the insurance page are disabled. Note that if insurance has been entered against a project, this option can 
no longer be disabled.

Date Received

The date that the project was received. Defaults to today's date when a new project is being created.
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Date Approved

The date that the project was approved. Please note that if the date is set, but the project status is not set to ‘Approved’, the 

system sets the status when changes are saved. 

Date Expected Start

The date that the project is expected to start. Note that if a date is specified, it needs to be after the Received Date.

Date Expected Completion

The date that the project is expected to complete. Note that if a date is specified, it needs to be after the Received Date.

Date Closed

The date that the project was closed. If a date is set here, a corresponding closed status should be selected, otherwise an 

alert  is created.

 Next Ethics Review Date

Provides a simple date entry for the next ethics review date. If the entered date is within the configured alert period, the 
system :-

1. Creates an alert ,

2. Turns this label red,

3. Turns the label on the Compliance page under the ethics section red.

The  button takes the user to the Compliance page. 

Note that this is only available/editable where the ‘Ethics Review Type’ requires an ethics review.

This date is removed once a project is closed.

 Next Progress Report Date

provides a simple (and initial) date entry for the next progress report date. Only entered here initially to trigger the first 
progress report reminder, since the first actual progress report captures a “Date Valid To” field, that in turn sets the new 

next progress report date. The  button takes the user to the  Progress Report page. This date is defaulted to 

“Approved Date” plus 12 months if not specifically entered when the project is being approved.

This date is removed once a project is closed.
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 Next Insurance Renewal Date

Can only be set via the Compliance – Insurance screen. If the “Is Insurance Required” option is set, this option is enabled. 

The  button takes the user to the Compliance - Insurance page. 

This date is removed once a project is closed.

If the "Is Insurance Required" flag was accidentally ticked, and you need to clear the date field, simply un-tick it, save the 
change, and the date will blank itself.

 Date Archived

The date that the project was archived. If a date is set here, a corresponding archived status should be selected, otherwise 

an alert  is created. Once set, the projects status icon changes to archived ( ), with the tooltip providing details.

 Dispose On Or After Date

Is the date at least X years beyond the Closed Date. X is defined in the “Can Dispose X Years After Close” section, and 

cannot be less than the minimum years defined for the selected project  Category (or overridden by some statuses). This 

minimum value is not displayed by the system; however it is defaulted, and validated during project saves, so the system 
will let you know if the value is lower than the minimum required. To force the minimum, set a value of zero (0), and the 
system will set the minimum for the category (or status). Once a valid date is specified, the system blocks changes to the 
“Can Dispose X Years After Close” field. A trick here (if you are unsure how the minimum is being derived) is to enter one 
(1), which is most likely less than the minimum, and the alert displayed blocking the save will give you full details of why one 

(1) is to low – hence how the system is deriving the minimum. Any issues here creates an alert .

 Disposed Date

The date that the project was disposed. If a date is set here, it needs to be today or in the past, and after the Dispose On 
or After Date, which in turn needs to be X years after the Closed Date. Once set, the projects status icon changes to 

disposed ( ), with the tooltip providing details. Any issues here creates an alert .

 Invoicing Details 

The projects invoicing details can be entered in this section.

Items of note are :-

· Project Invoice Summary - gives a summary of total amount invoicable, and outstanding,

· Invoice Amount - is the invoicable amount for the project,

· Agreed Document Amount - is the default invoice amount that will appear for documents if they are flagged as 
billable. Can be left at '0.00' if no default document amount applies.

All other fields are as is, and can appear in reports and can be searched in advanced search.

Note that any/all dollar values are entered as per user requirements regarding GST/VAT. If the policy is to store ex-GST 
values, then enter these, otherwise enter inc-GST totals.
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 Is Invoiced 

Indicates whether the project has been invoiced or not. Note that this flag is defaulted to not-invoiced, and is disabled if the ‘

 Billability’ option is set to a non-billable option.

The advanced search supports finding non-invoiced projects via the 'Can Invoice' and more specifically the 'Project Can 
Invoice' search options.

 Project Documents

The project may contain references to many different ‘documents’. These references can be entered into the system, and if 
required, the soft-copy of the document can also be uploaded with each document reference. The document reference, if 
not used in another area of the system (Action, Amendment, Device, Drug, Insurance, SAE or Update), can also be deleted. 
The aim of entering references for all project documents is to be able to track documents, regardless of whether you keep 
hard-copies in a filing cabinet, use the HRECTrack document upload, or use a third party electronic document repository.

It is important to note that document details (with or without a soft copy) need to be entered into in the system before they 
can be associated in other areas of the project. For example, say an insurance update arrived for a project. It is best to 

enter the insurance document reference here first, then go to the  Compliance - Insurance area of the project and enter 

the details, since you can then associate the document reference while entering the insurance details. 

A useful tip here is that while the 'Description' field is not mandatory, it is helpful to enter text, as this is used as a prefix in 
the dropdown selector in other areas of the system when associating the document references. The example below shows 
an insurance document description, and how it appears in the Compliance - Insurance edit page :-

  
Note that Closed projects can have documents of type 'Progress Report' added (for use in the  Progress Reports area).

Meeting and Date Approved
Documents can be sent to a meeting to be 'approved' by selecting the desired meeting date in the drop down.

If a document has its Date Approved set to a date other than the selected meeting date, it is deemed to be 'approved 
between meetings', and it will appear on the 'Approved Between Meetings' document list for the meeting following the 
selected date. It will NOT appear as a document requiring approval at the meeting!
In the example above, if the 'Date Approved' is set to 10-Aug, then the document appears on the 'Approved Between 
Meetings' list. If set to 15-Aug, it will appear as a document in the Meeting Management module, and comments can be 
added against the document.

Users can also associate the document with other meetings via the meeting management   option.

The meeting management  icon may also appear offering meeting status details in the tooltip.

 Billability /  Is Invoiced 
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Please note that the ‘Is Billable?’ option will be greyed out if the project is not flagged as billable. 

Likewise, the ‘Is Invoiced?’ and 'Invoice Amount' option may be greyed out if the document is not flagged as billable.

If the 'Is Billable?' option is checked, please ensure that the ‘Is Invoiced?’ option is also checked once invoiced, to ensure 
consistency for reporting.

The 'Invoice Amount' field requires a numeric value (no dollar sign), and may default from the Project's default 'Agreed 
Document Amount' if it is non-zero (non $0-), and the 'Invoice Amount' field is left at zero dollars ($0-) when saving the 
record.

The advanced search supports finding non-invoiced documents via the 'Can Invoice' and more specifically the 'Document Can 
Invoice' search options.

Note that to access Invoice details once 'Is Billable' is ticked, you may need to save the record first (as this applies additional 
business logic). 

Note also that some document types may default to billable when the project is billable.

 Documents

A document is approved once its approved date is reached, and is deemed ‘ratified’ if a meeting date has been set and has 

passed. Documents with a past meeting date, which have no approved date set, raise an alert . Users can also associate 

the document with other meetings via the meeting management   option.

If a soft-copy is uploaded :-

1. it needs to be less than eight (8) Mb in size (defined in configuration),

2. it must match the allowed document types that can be uploaded (doc, docx, xls, xlsx, pdf, etc),

3. it is renamed during upload to be “<original name>_yyyyMMdd_HHmmss.<original file type>,

4. the option exists to try to convert the file to a PDF on upload, storing the converted PDF instead of the file you 
requested to be uploaded.

Because the uploaded file is uniquely renamed, it is possible to ‘orphan’ a previous document if a new soft-copy is uploaded 
(associated with a document reference). If this occurs, an area below the document list displays the ‘orphaned’ documents, 
allowing you to view or delete them. 

Orphans can also occur if the document reference is deleted, and it had a soft-copy associated.

The system can also attempt to convert uploaded documents to the PDF format if required. By selecting the 'To Pdf?' option 
before saving, the system attempts the conversion, and if successful, references the converted PDF; otherwise the original 
file is kept and referenced. Note that the default value for the 'To Pdf?' option is defined in configuration, so can be changed 
to suit your preference.

Where E-Docs is enabled, you can also associate an uploaded E-Doc (document  type only) directly from a drop down.
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n.b. that if you browse and select a document, and select an E-Doc, the selected document 'wins', and the E-Doc selection is 
ignored.

Document(s) appear throughout the system via these icons on paginated lists and some tooltips :-

 - no document associated (yet),

 - document is associated, and clicking the icon will open the document,

 - a document is specified, and was uploaded, but cannot be found.

HRECTrack can also be switched to reference an external document repository, and allow the user to paste in the URL 
reference to the document in the external system; rather than uploading the document itself. In this mode, the following 
icons are used :-

 - no document URL specificed (yet),

 - document has a URL, and clicking the icon will open the document.

The project advanced search function allows the contents of some documents to be searched. When the contents of 

document(s) allow projects to appear in a search result, the relevant Project Document row(s) will have the   icon 
displayed on their status area, and the icon tooltip indicates the reason the icon is visible.

n.b. The meeting date selector offers only available meeting dates, except administrative users who can also select the 
previous meeting date.

 Project Actions

Project actions enable action or to-do items to be placed against the project. 

Outstanding actions and future actions that are due soon create an alert . Actions are outstanding when they have no 
approved date, or the approved date has not yet passed. An action is approved once its approved date is reached, and is 
deemed ‘ratified’ if a meeting date has been set and has passed. Future actions have a ‘Date Action By’ set, with no 
approved date specified, and they generate an alert when the action by date is approaching.

In addition, a document and User can be associated with the action item. 

Please note that users include :-

· all Administrator users,

· all HREC Member type users who are linked to a HREC Member,

· all Sponsor type users who are linked to a Sponsor that has visibility to the project,

· all Research type users who are linked to a Researcher that has visibility to the project.

For details on linking, see the Linking Users section.

Action Required is mandatory for an action, and outcomes can be entered.

n.b. The meeting date selector offers only available meeting dates, except administrative users who can also select the 
previous meeting date.

n.b.b. The meeting management  icon may also appear offering meeting status details in the tooltip.

 Project Progress Reports

Progress reports may be required, and the initial reminder is set via the “Next Progress Report Date” on the project edit 
page. 
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When the first progress report entry has been made, future reminder dates are based on the greatest “Valid To Date”. 

Progress reports must be presented at a meeting, hence the initial prompt fields. Progress reports have three (3) states :-
1. Past – where the report is “Ready To Submit”, and the meeting date has passed,

2. Scheduled - where the report is “Ready To Submit”, and the meeting date is in the future,

3. Pending – where the report is not “Ready To Submit”. Pending progress reports create an alert .

Participant numbers are also captured, and they include targeted, screened, current, and withdrawn.

The “Notes” field supports the conversion of text to special characters, as per the “Interface Overview” section at the start 

of the document.

A flag can also be set indicating that the report is the 'Final' progress report. 

If ticked, the system will also save the project :- 

· status, and 

· closed date

fields.

Note that the "Valid To Date" is generally mandatory, however it is NOT required for :-

· Update has 'Is Final Update' ticked, or

· Project is Closed, or

· Projects where Ethics Review Type is 'Governance Only' (except Cabrini).

Note also that Closed projects can have progress reports added.

 Project Compliance – Governance and Ethics

The core governance and ethics fields is the default screen behind this icon.

It can also be accessed via the  on the “Compliance – Insurance” screen, via the upper link on the icon 

tooltip , or via the  option on the project edit page 

..

 Compliance - Governance

The compliance section consists of generic questions and answers in a common format of a simple value response, and 
optional description. 

Tooltips over each field provide full details. 

Note that additional options can easily be added here - so if you need more items just ask.

In addition, a section titled “Approved Site(s) – none defined” may appear. This enables sites covered by the 
governance/ethics approval to be selected. Site(s) can be setup/added if required, as initially there are none defined. An 
example is :-
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Below 'Approved Site(s)' there may also be some custom options replacing some of the generic ones mentioned above for :-

· Participant Consent (with Applies To),

· Privacy,

· Tissue Storage,

· Headers & Footers,

· Departmental Support (with optional 'Other' text).

 

 Compliance - Ethics

The ethics section may vary depending on the selected  Ethics Review Type.

When the “Governance Only” option is selected, it indicates that a third party has provided the ethics approval (i.e. not your 
ethics office or ethics committee). Accordingly, the system requires data to be entered relating only to this third party ethics 
approval :-

Other options for the Ethics Review Type indicate that either your ethics office (internal) or committee (external) will be 
providing the review, then the data required differs slightly, and relates to your internal/external requirements.
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Please note that the Reviewing HREC ('third party') ethics section is still available. This is for the scenarios where your ethics 
office or committee does a review, however, you still need to make note of a another HREC's ethics review. 

By default, the "Reviewing HREC" area is hidden, and remains hidden if no values are filled in. It can be displayed or hidden 
by selecting the heading area; and will automatically display if there are any entered values.

An option is always available for Ethics Comments :-

The “There are no ethics checklist options defined.” note that may appear after this section indicating that there are no 
additional generic ethics questions defined for your HREC – similar to the compliance list in the upper section. This is, 
however, available if required.

 Project Compliance – Insurance

Insurance details are enabled if the “Is Insurance Required” option on the project edit page is selected.

It can be accessed via the  on the “Compliance – Governance and Ethics” screen, via the lower link on the 

 tooltip , or via the  option on the project edit page 
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 tooltip , or via the  option on the project edit page 

.

If insurance is required then its details must be entered up front. The “Valid To Date” field determines when the next 

insurance alert  will be raised.

The “Insurance Provider” and “Insurance Notes” text areas supports the conversion of text to special characters, as per the 

“Interface Overview” section at the start of the document.

 Project Drugs

Records details of any drugs for the project.

The “Details” field supports the conversion of text to special characters, as per the “Interface Overview” section at the start 

of the document.

 Project Devices

Records details of any devices for the project.

The “Details” field supports the conversion of text to special characters, as per the “Interface Overview” section at the start 

of the document.

 Project Researchers

Enables the association of researchers to the project as either co-ordinating/chief (CI), principal (PI), or associated 
researchers. 
Since there is also a need to associate a person as a contact (who may or may not be a researcher) then this area does this 
as well.

The principal (PI) researcher is the main researcher reference of interest to the project, hence an option to select the PI is 

also available on the Project > Edit page. 

In addition to specifying the CI / PI role type of the researcher on the project, other options can also be selected, namely :-

 Allows editing of the link, specifically the notes.

 Chief Investigator - select to change the CI/PI (as per the Project > Edit page).

 Contact - this is the contact (who may or may not be a researcher) to whom mail and faxes are sent, and phone calls 
made.

 Mail To Researcher - this is the researcher to whom all correspondence should be directed/addressed. In most cases, 
this person will be the CI or PI. By default, the system makes the first researcher added to the project (generally via the 

Project > Edit page) the Mail To researcher. It is important because this setting is used to produce letter heads, and 

labels. Note that where the Mail To and Contact researchers are different, the mailing label will be in the format :-
Mail To Researcher Name
c/- Contact Researcher Name
Contact Researcher address details...

and the correspondence itself will only make mention of the Mail To Researcher.

 Invoice To Researcher (only available if the project is billable) - the researcher to whom invoices will be sent.

 Researcher CV (Resume), with the following indicators :-
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·  - no document associated (yet),

·  - document is associated, and clicking the icon will open the document,

·  - a document is specified, and was uploaded, but cannot be found.

 /  The researcher can also be made active/inactive on the project. This option is also a mechanism to clear other 
options for a project researcher, by toggling them to inactive, which removes all other selected options, then activating them 
again. 

The tooltip over the  option on the projects page provides details of all three (3) types of contact, as well as relevant links 
based on their contact types (e.g. email,web page, etc). The Mail To and Invoice To researchers will also be indicated if 
specified. 

Researcher details must be entered and modified via the Administration > Researchers section. 

This includes the contact; who may not be an actual researcher.

Researchers can also be linked to Users via the Administration > Users > User Edit page (for Researcher type users). 

If they are linked, then the interface shows the  icon on the list for that Researcher. 

In addition, the user now gets to 'see' this project by default; as per the Project Users page.

 Project Previous Links

Enables previous projects of interest to be associated with this project. When this occurs, the current project gets a previous 
link, and the previous project gets a future link in the tooltip. 

If the project has previous project links, or is referenced by a future project, the icon changes to the  image. Also, all the 
project code(s) in the tooltip become a hyperlink which when selected runs a filter for that project code.

 Project Sponsors

Enables the association of sponsors with the project, as well as a principal sponsor. 

The main Sponsor details must be entered and modified via the Administration > Sponsors section.

The Sponsor Key Contact field can be 'overridden' when linking to a project, just in case something differs from project to 
project. 

To revert back to the main Key Contact for the sponsor, simply blank the entry and save.

n.b. The text box may not display an empty value, as it will always display either :-

· the specific Key Contact override applied to the project, or

· the main Key Contact.

n.b.b. On selecting a Sponsor from the drop-down, select 'Save' to see the current/default Key Contact person. 

Sponsors can also be linked to Users via the Administration > Users > User Edit page (for Sponsor type users). 

If they are linked, then the interface shows the  icon on the list for that Sponsor. 
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In addition, the user now gets to 'see' this project by default; as per the Project Users page.

 Project Users

Enables the association of users with the project. 
By default, Administrator users are automatically associated with every project. 

Other user types need to be associated with each project manually, except where users are associated with a HRECMember, 
Sponsor, or Researcher.

This link is made the Administration > Users > User Edit page.

Where a link  is indicated in the status column, and no remove option  is offered, it indicates that the user has been 
automatically associated with the project.

The tooltip over the  icon indicates the reason for the automatic association.

If the icon  also appears, it indicates that the user has been associated because they have been linked to a HRECMember, 
Sponsor, or Researcher; who in turn has an association with the project.

By default, the list is ordered by :-
· User Type,
· Last Name,
· First Name.

 Project Timers

The project timer was added to allow tracking of quality of service for project approval/rejects. 

It is automatically triggered when a new project is created, based on the “Received Date”, and is automatically terminated 
when the project is approved or closed. 

All other start/stop triggers/events need to be set by the user.

Only one timer can exist spanning any given day. If a timer is started and stopped on the same day, it counts as one (1) day. 
If a timer is started and stopped on the same day, and the time is started again on that day, the original record for that day 
is voided, and a new one started.

The timer has two (2) configuration settings that relate to its functionality :- 
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1. ProjectTimerAlertDays – number of days before a critical alert is triggered.
2. ProjectTimerInWeekdayDays – determines if day counts are in calendar days or weekdays. Both these values are 

displayed in the table above, and in the tooltip, however this setting determines the type of day count used for alerts.

Note that a third configuration setting, ‘DateAlertDaysProjectTimer’, may contribute to urgent alerts. If 
DateAlertDaysProjectTimer is less than ProjectTimerAlertDays, then an urgent alert is raised DateAlertDaysProjectTimer 
days before the ProjectTimerAlertDays are reached.

Any issues with the timer raises an alert .

 Project Severe Adverse Events

Project severe adverse events enables tracking of adverse events , and can capture a number of flags that relate to these.

The flags include :-

 - was it drug related,

 - was it device related,

 - was it connected to this HREC,

 - were death(s) involved,

 - link to previous SAE.

A document can also be associated with the event, and outcomes listed.

Creating severe adverse events sets the  status icon visible against the project, and the tooltip provides a basic listing of 
the events.

n.b. The meeting date selector offers only available meeting dates, except administrative users who can also select the 
previous meeting date.

n.b.b. The meeting management  icon may also appear offering meeting status details in the tooltip.

 Project Amendments

Project amendments enable the tracking of amendments against the project. 

Outstanding amendments create an alert . Amendments are outstanding when they have no approved date, or the 
approved date has not yet been reached. 
An amendment is approved once its approved date is reached, and is deemed ‘ratified’ if a meeting date has been set and 
has passed.

In addition, a document and HRECMember can be associated with the amendment item. 

Detail is required for an amendment, and notes can also be entered.

n.b. The meeting date selector offers only available meeting dates, except administrative users who can also select the 
previous meeting date.

n.b.b. The meeting management  icon may also appear offering meeting status details in the tooltip.

 Project Communications

It should be stated up front, the purpose is not to replace, or interface to, an organizations email system; which has its own 
backup and archiving mechanisms and policies.
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Project communications enable the tracking of emails, correspondence, phone calls, etc against the project. 
Communication details include :-

· Date,
· Type (phone, fax, email, etc),
· With - allows details of who was involved in the communication,
· Detail - details of the communication.
· Associated Document.

Additionally, an  action item can be created/updated, with the following code details :-
· Date Action By,
· Action Required,
· For User.

Communication details can also be searched via the Advanced Filter.

To assist in the logging of email correspondence, email files like Outlook (msg) and Mail (eml) files can be dragged onto or 
selected via the 'Email Drag/Drop Zone' on this page.

If this is performed, the following occurs :-
1. A communications entry is created (of type Email), with all details of the email logged,
2. Any relevant/allowable attachments are associated as Project Documents (converting to PDF as required),
3. The first relevant/allowable attachment is associated with the communications entry from step 1.
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11. Reports

 Reports

Reporting is integrated into many areas of the HRECTrack system, not just the Reports page.

Current supported output formats are Microsoft Word, Excel, and Adobe PDF (the icon next to the report name indicates the 
output type of the report).

Selecting a report starts a small popup window that runs the report, and your browser should then offer you the option to 
open or save the generated file. 
(n.b. that this option may appear on the bottom of the screen in newer browsers!)

Reports Page

Depending on the system configuration, the reporting page will show either a custom web page (internal or external), or a 
list of general reports as defined in the HRECTrack database.

 Integrated Reporting

Reporting is integrated into the HRECTrack system via the  reporting icon. 

The icon appears next to the filter  at the top of most lists, as well as at the end of each row in the 'Options' column of 
the lists.
Hovering over this icon displays a tooltip with the relevant links to the contextual reports that are available.
In this way, you can produce reports on the current list (filtered or all records), or just for the list item. 

The example below indicates five (5) reports that are available :-

Customised Reporting

It's easy to get your own report formats, with headers, footers, and content just the way you like it.
Simply produce a sample in Microsoft Word, send it to the support team, and we'll integrate it into the relevant area of the 
system.
All we need to know is :-

· where you would like the report to appear, and
· what label you would like to appear on the menu, also
· what output formats you would like for the report (Microsoft Word doc, docx, pdf, etc).
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12. Administration

 Administration Overview

Administration is required to drive many of the project options in the system.

It enables system users to be created, as well as researchers, HREC members, and sponsors, which are subsequently 
associated with projects. Many of the administrative options reflect in tooltips on the project screens, like Researcher 
contacts, and any changes made in the administration module are automatically reflected throughout the system.

12.2. Meetings

 Meetings Overview

Administering meetings enables them to be added, edited, and disabled. Disabling stops them appearing in any selection list. 
Meeting duration (in hours) can also be captured.

To provide exception handling, use the meeting notes field – on the  “Edit” meetings page. In this way comments can be 
added regarding HREC members who absented from certain project discussions, and the like.

There are also a number of dates associated with specific meetings, namely :-

· Meeting date,

· Published cutoff – is the 'published' cutoff date which is used for display purposes only,

· Internal Project Cutoff – is the internal project submission cutoff date, which affects the meetings available to new 
projects (in the dropdown),

· Internal Documentation Cutoff – is the internal documentation cutoff date, which affects the meeting dates available 
to project documents that require submitting (in the dropdown).

The meeting documents, namely :-

· Executive Agenda,

· Agenda,

· Executive Minutes,

· Minutes

can also be saved against a meeting.

In addition, members can be associated with a meeting (via the  option), and flagged as attended, offering apologies, 
offering comments, and whether they are the chair person for that meeting.

The meeting members screen is slightly different to others, in that the options (right hand side) are actioned/toggled simply 
by clicking (no further screens are displayed), and when the screen refreshes, the status (left hand side) is updated to 

reflect the previous selection. Select the  button to return to the meeting list.

There are two (2) ways of filtering the meetings list :-

1. Using the  advanced filter (see details on filter criteria here) or

2. Entering basic text into the search text box and selecting the ‘Filter’ button.

In either event, the tooltip for the filter text box displays the filtering criteria that will be used. Refer to the advanced filter 
section for more details. 

 Meeting Management

The Meeting Management module allows users to view/review on a single page all projects, and any associated project :-
· documents, 
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· actions, 
· progress reports, 
· amendments, or 
· severe adverse events 

associated with a meeting. 

Additionally, comments can be recorded against each item. 
The intent of this module is to allow users to manage the meeting by having all the relevant items appear as the basis for 
the meeting agenda.

To facilitate sharing during the course of the meeting, this module allows you to :-

· open any relevant documents via  and display these on a second screen (or projector) for group display,

· click the  comment button to open a movable pop-up window that has automatic 2-way synchronization of any 
text typed in either window. 

Quick links are provided against each item to :-

· Edit the item, or

· View  the document.

The full set of project actions are also available for each project, as per the project listing and header options.
When these options are selected, you are taken to the relevant project section in HRECTrack. To provide an easy 

mechanism to return to the Meeting Management module, the  icon appears next to the navigators in the top right hand 

corner of the project pages (in the project header).

 Documents Approved Between Meetings
Not all documents that have a meeting selected in the drop-down will appear at the meeting!
See Meeting and Date Approved for details, but essentially if it is also approved before the meeting, then it appears on the 
document 'Approved Between Meetings' list for the meeting, rather that at the meeting in this management module for 
commentary.

IMPORTANT NOTE: The Update (Save) options float at the bottom of the screen for easy access at any time. The 
system does NOT track changes to text on the page, and will NOT prompt you to save any unsaved changes before 
navigating to another page. Please Update (Save) regularly!

12.3. Researchers

 Researchers Overview

Administering researchers enables them to be added, edited, and disabled. Disabling stops them appearing in any selection 
list for projects. 
In addition, they can have numerous address and contact details, as well as designating one of each as a primary 
address/contact; these in turn appear in the tooltips of the project listing page for the project researchers.

By default, the list is ordered by :-

· Last Name,
· First Name.

There are two (2) ways of filtering the researchers list :-

1. Using the  advanced filter (see details on filter criteria here) or

2. Entering basic text into the search text box and selecting the ‘Filter’ button.

In either event, the tooltip for the filter text box displays the filtering criteria that will be used. Refer to the advanced filter 
section for more details. 
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Two (2) document types can be stored against a researcher :-

· Curriculum Vitae (CV/Resume), and 

· Non-Disclosure Agreement / Confidentiality Agreement (NDA/CA).

These can be viewed in the Researchers list, and the CV is also viewable on the Project Researchers list.

The system can also attempt to convert uploaded documents to the PDF format if required. By selecting the 'To Pdf?' option 
before saving, the system attempts the conversion, and if successful, references the converted PDF; otherwise the original 
file is kept and referenced. Note that the default value for the 'To Pdf?' option is defined in configuration, so can be changed 
to suit your preference.

Where E-Docs is enabled, you can also associate an uploaded E-Doc (document  type only) directly from a drop down.

n.b. that if you browse and select a document, and select an E-Doc, the selected document 'wins', and the E-Doc selection is 
ignored.

n.b.b. if you select the same E-Doc for both the Resume and NDA, then it will only be allocated against the resume.

Researchers Resume/CV (and NDA/CA) appear throughout the system via these icons on paginated lists and some tooltips :-

 - no document associated (yet),

 - document is associated, and clicking the icon will open the document,

 - a document is specified, and was uploaded, but cannot be found.

Researchers can also be linked to Users via the Administration > Users > User Edit page (for Researcher type users). 

If they are linked, then the interface shows the  icon on the list and edit pages for that Researcher. 

In addition, the user now gets to 'see' all projects where the Researcher is associated via the Project Researchers page.

The Project Users page indicates this automatic link for the Researcher user, with details in the tooltip of the  icon.

12.4. Sponsors

 Sponsors Overview

Administering sponsors enables them to be added, edited, and disabled. Disabling stops them appearing in any selection list. 
In addition, they can have numerous address and contact details, as well as designating one of each type as a primary 
address/contact. 

These in turn appear in the tooltips of the project listing page.

By default, the list is ordered by :-

· Last Name,
· First Name.

There are two (2) ways of filtering the sponsors list :-
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1. Using the  advanced filter (see details on filter criteria here) or

2. Entering basic text into the search text box and selecting the ‘Filter’ button.

In either event, the tooltip for the filter text box displays the filtering criteria that will be used. Refer to the advanced filter 
section for more details. 

Sponsors can also be linked to Users via the Administration > Users > User Edit page (for Sponsor type users). 

If they are linked, then the interface shows the  icon on the list and edit pages for that Sponsor. 

In addition, the user now gets to 'see' all projects where the Sponsor is associated via the Project Sponsors page.

The Project Users page indicates this automatic link for the Sponsor user, with details in the tooltip of the  icon.

12.5. HRECMembers

 HREC Members Overview

Administering HREC Members enables them to be added, edited, and disabled (via checkbox and if tenure expires). Disabling 
stops them appearing in any selection list. 
In addition, they can have numerous address and contact details, as well as designating one of each type as a primary 
address/contact. These in turn appear in the tooltips of the project listing page.

By default, the list is ordered by :-

· Last Name,
· First Name.

Please note that the list of HREC Members on this page displays  enabled members first, by surname, then  disabled 
members by surname.

There are two (2) ways of filtering the HREC members list :-

1. Using the  advanced filter (see details on filter criteria here) or

2. Entering basic text into the search text box and selecting the ‘Filter’ button.

In either event, the tooltip for the filter text box displays the filtering criteria that will be used. Refer to the advanced filter 
section for more details. 

An impending members tenure expiration will raise an alert on the Dashboard > System Messages, as well as via the 

status icon . To remove the issue, you can :-

1. extend the tenure, or

2. disable the member (via the edit page), which also removes them from the HREC Member selectors that appear around 
the system.

HREC Members can also be linked to Users via the Administration > Users > User Edit page (for HREC Member type 

users). 
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If they are linked, then the interface shows the  icon on the list and edit pages for that HREC Member. 

In addition, the user now gets to 'see' all projects where the HREC Member is associated with the :-

· project, or

· actions, or

· documents, or

· amendments, or

· severe adverse events.

The Project Users page indicates this automatic link for the HREC Member user, with details in the tooltip of the  icon.

12.6. Users

 Users Overview

Users need to be defined to allow people to log into HRECTrack.
Administering users enables them to be created, edited and disabled. 

Disabling stops them appearing in any selection list, and also means they cannot login.

By default, the list is ordered by :-

· User Type,
· Last Name,
· First Name.

Status options displayed include :-

·  /  User type,

·  /  User status,

·  User is currently logged in (n.b. that this can also indicate that the user did NOT specifically log out after last 
use),

·  User password change is required at the next login,

·  User failed login retries have been exceeded (n.b. it will reset after a period of time - see login for details),

·  User is linked to a HRECMember, Sponsor, or Researcher (see below and Project Users for further details),

·  User alert.

Options include :-

·  Edit the user,

·  Reset password to 'password', and force user to change it at next login,

·  Start an email for the user,

·  Resets the login failures counter for a user (n.b. it will reset after a period of time - see login for details),

·  Only available for some Administrators, it allows special access to diagnostics,

·  User Reports.
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User Types can be created or modified to have different permissions throughout the system.

The User Type column tooltip on the grid specifies the security permissions for that user type.

On the edit page, the information  icon toggles an area that displays the permission for the selected user type. 

There are two (2) ways of filtering the users list :-

1. Using the  advanced filter (see details on filter criteria here) or

2. Entering basic text into the search text box and selecting the ‘Filter’ button.

In either event, the tooltip for the filter text box displays the filtering criteria that will be used. Refer to the advanced filter 
section for more details. 

 Linking Users

Linking a user with a HREC Member, Researcher or Sponsor allows the user to 'see' those projects with which the relevant 
HREC Member, Researcher or Sponsor are associated. 

For the link to occur, the User Type must be the same as the type you want to link to (i.e. HREC Member, Researcher or 
Sponsor), and the link can only be made AFTER the user is initially saved.

Automatic association for users to projects (as per the Project Users page) occurs for the different types by the following :-

· Sponsors - a user linked to a sponsor can 'see' all project(s) that the sponsor is associated with via the  Project 
Sponsors page,

· Researchers - a user linked to a researcher can 'see' all project(s) that the researcher is associated with via the  

Project Researchers page,
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· Researchers - a user linked to a researcher can 'see' all project(s) that the researcher is associated with via the  

Project Researchers page,

· HREC Members - a user linked to a HREC Member can 'see' all project(s) that the HREC Member is associated with 
via the project :-

·  edit, or

·  actions, or

·  documents, or

·  amendments, or

·  severe adverse events.

Linking is a useful way to give HREC Members, Researchers or Sponsors easy access to the system, and automatic 
association to the relevant projects.

It also enables the user to edit basic details (non-core fields, contacts, and addresses) of their relevant type (i.e. HREC 
Member, Researcher or Sponsor), thus alleviating some of the overhead for administrators.

Please note that if the user type is changed, any link is reset.
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13. Help

 Help

The Help tab offers some basic support and diagnostic screens.

Help

The main help screen provides basic information about the system, the current user, and their system permissions.
Access to this help system, as well as an option to email support are provided.

Whats New

The What's New page provides details of what's changed, release by release.
After a major release, you may be directed to this page after the first login, so that you are aware of what has changed.

Terms & Conditions (Ts & Cs)

The Terms And Conditions page provides details of the HREC's usage policy for HRECTrack.
Accepting these terms, on a periodic basis, is a requirement of ongoing system usage.

Diagnostics

Available to administrators only, the diagnostics page allows testing of various user interface controls, as well as 
information on system configuration.
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